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November 16, 2018 
 

Category Review of Mainstem and Program Support Projects   
In the Fish and Wildlife Program for FY 2020 and beyond 

 
 
Dear Project Sponsors: 
 
The Northwest Power and Conservation Council (Council) and Bonneville Power 
Administration (Bonneville) announce the start of the review process for Mainstem and 
Program Support projects funded under the Council’s Columbia River Basin Fish and 
Wildlife Program (Program). These mainstem and program support projects generally 
focus on addressing management questions with broad applicability or play a supporting 
role in the synthesis of basin-wide information and implementation. There are 50 projects 
included in the Mainstem/Program Support Category Review (see attached list). 
 
This packet contains the review schedule, information your project team will need to 
complete the project proposal form, and contact information, in case you have questions. 
All information contained in this packet also can be found on the Council’s website here.  
 
The Council appreciates your participation in this review and we look forward to working 
with all to ensure the projects are successful. 
 
 
Review Materials are due by midnight, January 30, 2018.  
 
Most of these projects have been the subject of numerous reviews in the past. For that 
reason, important functions of this review will be to  

• evaluate project results and determine whether and how each project has adapted 
proposed future work based on those results  

• evaluate how well the project sponsors have responded to the scientific and 
management issues identified in previous Council reviews and recommendations  

• evaluate the collective progress of particular groups of projects that have similar 
focus  

 

https://nwcouncil.box.com/s/vp9mz76f2ksgvu7dzrcmqn91dtwvlayl
https://www.nwcouncil.org/fish-and-wildlife/fish-and-wildlife-program/project-reviews-and-recommendations/mainstem-review
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This review is limited to ongoing projects, new Columbia Basin Fish Accord projects, and 
any projects that have not been reviewed by the Independent Scientific Review Board. 
This is not a solicitation for new work. However, sponsors of ongoing projects may 
describe new work elements, phases, or new objectives for their projects based on 
adaptive management and new priorities, within the organization’s portfolio of projects. All 
updated information for this review will be submitted and reviewed through cbfish.org.  
 
Instructions for submitting proposal forms are included on page 5 -- “Getting Started”. 
 
Review Schedule Summary 
 
Mainstem/Program Support 
Review Steps 
 

Date 
 
 

Review Start Date  November 16, 2018 

Review Materials Due January 30, 2019 

Presentations February 25-28, 2019 

ISRP Preliminary Report  April 4, 2019 

Public Comment begins April 5, 2019 

Responses Due April 30, 2019 

Final Report May 30, 2019 

ISRP Presentation to Council June 11, 2019 

Committee Recommendations July 16, 2019 

Public Comment ends July 26, 2019 

Council Recommendations August 13, 2019 
 
* Dates for Committee and Council recommendations may change depending on public comments, 
but sponsors will be notified if that happens.  
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Schedule and General Information  
 
Process Steps and Schedule  
This packet marks the start of the proposal phase in which project sponsors update their 
project proposals in cbfish.org. All review materials are due by midnight on January 
30, 2019. The Council will make proposals available to the ISRP for review on January 31.  
 
Electronic Proposal Form 
The online proposal form in cbfish.org has been updated since the 2010-2013 category 
reviews. However, the basic structure is still largely the same. Once you initiate the 
proposal form process and find your project proposal name and number, the pre-loaded 
proposal form will require mostly updating and revising your content. The pre-entered 
information will include the narrative and typed fields from your previous proposal (problem 
statement, objectives, deliverables, etc.). See FAQ’s below for further instruction on editing 
and updating your proposal. 
 
Proposal Form Assistance  
Here are ways to get oriented to the proposal form and to get help if you need it:  
 Getting Started – see the section below (initiating the process and finding your 

proposal) 
 Instructional pop-ups in the form itself (additional detail on specific questions) 
 Frequently Asked Questions (FAQs) (editing, visibility, saving, etc.) 
 Useful Links (hyperlinks to relevant websites for Fish and Wildlife Program data and 

information, processes, and Biological Opinions) 
 
If you need more personal help, please contact Lynn Palensky (503-222-5161). Bonneville 
and the Council are considering holding a short webinar in early December to walk through 
the proposal form. If that is something you are interested in, send Lynn an email. 
 
Independent Science Review Panel Review  
Section 4h(10)(D) of the Northwest Power Act directs the Council to review projects 
proposed for funding by Bonneville to implement the Council’s Fish and Wildlife Program. 
The Council engages in this review with the assistance of the Independent Scientific 
Review Panel (ISRP) which was created by the 1996 amendment to the Northwest Power 
Act. The ISRP will review all proposals using criteria from the 1996 Amendment to the 
Northwest Power Act. The amendment states that the ISRP’s project recommendations be 
based on a determination that projects: 
 

• Are based on sound science principles  
• Benefit fish and wildlife  
• Have clearly defined objectives and outcomes 
• Have provisions for monitoring and evaluation of results, and  
• Are consistent with the Council’s Fish and Wildlife Program  

 
For individual projects, the ISRP review will focus primarily on project performance by 
assessing the following project components:  

• the degree to which project objectives are being achieved 
• accomplishments and results 

mailto:lpalensky@nwcouncil.org
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• the degree to which project objectives, actions, and methods reflect new information 
gained from those results – adaptive management 

• clear delineation of progress towards completion 
 

Because the ISRP is specifically charged with reviewing “results of prior year 
expenditures,” results reported through proposals and supporting documents will be critical 
to the ISRP’s evaluation.  
 
Project Presentations 
During the preliminary review, project presentations will be organized to share information 
about projects, add context to the proposals, and provide an opportunity for dialogue 
between the ISRP and project sponsors. Presentations should focus on results, 
accomplishments, adaptive management implications, and proposed work. Sponsors are 
encouraged to participate in project presentations as part of this review process. This 
exchange of information among project sponsors will help inform ISRP and Council 
recommendations. We have scheduled time for presentations during the week of February 
25 (likely Feb 25-28). Contact Lynn Palensky with any questions or early scheduling 
requests. (see below for details on scheduling).  
 
The ISRP will complete a Preliminary Review Report of proposals on April 4, 2019.  
 
The ISRP’s preliminary report will provide written recommendations and comments on 
each proposal. If the proposal does not contain sufficient information or if issues need to 
be clarified, the ISRP will request a response from the project sponsor that will be due 
April 30, 2019.  
 
The ISRP will review these responses and complete a final report by May 30, 2019. This 
report will include final comments on all proposals and on programmatic issues that apply 
across many projects, such as identification of information gaps and opportunities for 
coordination. 
 
The Council begins accepting public comments on the ISRP’s Preliminary Review Report 
once it is complete and posted on the Council’s website. The public comment period 
continues through the completion of the ISRP’s Final Report until late July when staff begin 
developing recommendations for Council consideration.  
 
Council recommendations  
Final Council recommendations will include explanations addressing specific requirements 
of Section 4(h)(10)(D) of the Northwest Power Act. This includes the written explanations 
required of the Council in those few instances in which the Council’s project funding 
recommendations do not follow the ISRP’s recommendations. The Council will also explain 
how it considered “the impact of ocean conditions on fish and wildlife populations” and 
determined whether the projects “employ cost-effective measures to achieve program 
objectives.” Council recommendations are anticipated in August 2019. 
 
 
  

mailto:lpalensky@nwcouncil.org
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Getting Started 
 

1. Follow these steps to begin working on your proposal:  
Go to www.cbfish.org 

2. Log in. If you don't have a username and password, click the "Request Support" link 
in the Help menu (upper right corner) to request a new account. 

3. Click the Explore button (upper left corner) and select Proposals. This will load the 
Proposals page. 

4. Select the Edit icon for your proposal to load the form. If you do not have an 
ongoing project, select the Create icon next to your project to load the form. 

 

 
 
 

http://www.cbfish.org/


 
 
 

Frequently Asked Questions (FAQ)  
For proposals in cbfish.org  

We’ve compiled this list of questions that we heard during usability studies with project sponsors from 
around the Columbia River Basin and have added a few that we anticipate for this review. Questions are 
loosely ordered according to the flow of the proposal form. 
 
Q: What is cbfish.org? 
A:  cbfish.org, also known as Pisces Web, is a public interactive site that provides information about the 
work funded by Bonneville Power Administration (BPA) to implement the Northwest Power and 
Conservation Council ‘s Columbia Basin Fish and Wildlife Program, which spans across a four-state region. 
The scope of this site includes project proposal information from Fiscal Year 2007 forward and project 
budget information from 2004 forward.  
 
For those familiar with “Pisces” and “Taurus,” cbfish.org recently incorporated the Pisces application in a 
project code-named “Gemini.” All three names refer to cbfish.org.  
 
Q: My proposal already has project information in the text fields; where did this come from? 
A: We copied the information from your previous proposal form into the new proposal form for you to edit. 
The financial information may look different than what was entered in your previous proposal form 
because it was updated with the latest budget numbers from BPA. 
 
Q: Why the long list of work elements associated with my project?  
A: A summary of all work elements (WEs) ever associated with your project are listed. You can use this 
comprehensive list of WEs to select those you want to include for proposed work. 
 
Q: What’s with the yellow banana icons in the left-side navigation bar?  
A: The bananas indicate sections of the proposal that are incomplete. You will need to enter the 
information necessary to turn the bananas to a green check mark to submit your final proposal. The green 
checkmarks indicate sections that appear complete, and since much of the information from your old 
proposal will be copied over to the new one, you are likely to see many green check marks the first time 
you view your proposal. You will want to check the sections marked with the green check to make sure you 
are satisfied with the content.  
 
Q: How can collaborators access my draft proposal for reviewing and editing?  
A: Only people who are logged on and who are members of the specified proponent organizations, and 
your BPA project manager, can see and edit proposals in Draft state. If you need to share your proposal 
with people associated with organizations not listed on the “Edit Basics” page of the proposal, you simply 
need to add their organization to that list (Ctrl-click and drag to select more than one proponent 
organization).  
 
Q: Can multiple people work on a proposal at the same time?  
A: Yes. However, we recommend you assign different people different sections so that two people aren’t 
simultaneously making edits to the same content (in which case the last person to save will overwrite the 
other’s edits). 

http://www.nwcouncil.org/
http://www.nwcouncil.org/
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Q: How do I preview what my proposal will look like to a reviewer? 
A: Click the “Summary” button at the top of the left-side navigation. This displays a read-only version of 
your complete proposal. We recommend you do this periodically as you fill out your proposal to see how 
your content will be presented to reviewers like ISRP, Council, and BPA. In general, the Summary view 
follows the same order as the proposal entry or “Edit...” pages, but not always. This Summary view also has 
a Print feature if you need a hardcopy. 
 
Q: How do I make the text on the screen larger? 
A: Most web browsers provide a way to “zoom in” such that the text on the page becomes larger. Try 
looking in the “View” for a “Zoom” or “Text Size” option. Some browsers also support the keyboard 
shortcut Ctrl + (plus sign) and Ctrl – (minus sign or dash). 
 
Q: Why is the Proposal Short Description so short – limited to only 500 characters?  
A: The short description is helpful for reviewers to very quickly reacquaint themselves with your proposal 
and may be used in summary reports/lists of proposals. The Executive Summary by contrast allows up to 
8,000 characters (or about 3 ½ pages) and provides you with space to more adequately provide a summary 
of your project.  
 
Q: Should I be worried that my contract deliverable “% Complete” is not 100% (on the Summarize History 
page of the proposal)? 
A: This is to be expected. Most projects have at least one contract that is currently underway, in which case 
they will have contract deliverables that have not started or are in progress, hence not yet complete. 
 
Q: Why do we limit the characters on many fields? 
A: Most text fields in the proposal are limited to a maximum number of characters, including spaces. The 
exceptions are rich text boxes, which have no limits. We placed limits on these fields to encourage sponsors 
to summarize information for reviewers.  
 
Q: What is a “project objective?” 
A: Project Objectives describe the qualitative and quantitative outcomes of an individual project. 
Qualitative, general objectives (Goals) describe ultimate, long-term desired outcomes. Quantitative 
biological, physical, or social objectives describe outcomes and are Specific, Measurable, Actionable, 
Relevant, and Time-bound (SMART). Project Objectives are achieved by completing one or more Project 
Deliverable (see next question). Also see “Defining project objectives” for details. 
 
Q: What is a “project deliverable?” 
A: Project Deliverables are quantitative implementation objectives that describe task-based outputs and 
are Specific, Measurable, Actionable, Relevant, and Time-bound (SMART). The Deliverables often span 
multiple years and may be accomplished through multiple contracts and multiple work elements. Project 
Deliverables are evaluated through implementation monitoring. Contract Deliverables, on the other hand, 
are smaller in scope and correspond with an individual work element.  
 
Q: Which project deliverables are the most important for me to highlight (on the Edit Deliverables / 
Budget page)? 

https://www.cbfish.org/Content/tutorials/ProposalFormOverviewGuidance-2018.pdf
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A: The goal is to provide a high-level view of what your project aims to accomplish or deliver in the coming 
years. Most projects will have anywhere from three to 10 project deliverables. If you find yourself adding 
20 or more project deliverables, make sure you haven’t defined them too narrowly. However, given the 
range in size and scope of projects in our program, these are only guidelines. 
 
Q: What happened to my images/charts (after pasting content from Microsoft Word into one of the 
proposal’s rich text boxes)? 
A: A few of the proposal questions/sections provide you with a rich text box editor (look for the toolbar), 
such as the Results: Reporting, Accomplishments and Impact question and the Problem 
Statement/Technical Background question. These rich text box editors allow you to format the text (bold, 
underline, font size, font face, color, etc.), add tables, insert images, etc. They can also accept content 
pasted from a Microsoft Word document. However, if your Word document includes in-line images/charts, 
they will not be pasted. After pasting the content, you will need to go to each place where there was an 
image/chart, and insert it using the Image Uploader tool on the toolbar. This is just like inserting an image 
into a Word document; it requires that each image/chart is somewhere on your local computer as a stand-
alone file. If your Word document has many images/charts, extracting each so that it is a stand-alone file 
can be time-consuming, so you might want to try the following: 
 

To quickly extract the images/charts from your Microsoft Word document  

The precise options/commands referenced above may vary slightly, depending on the version of 
Microsoft Word you have. 

1. Open your Word document containing the images you want to add to one of the Proposal 
"rich text" boxes.  

2. From File menu, choose Save As...  
3. In the "Format" or "Save as Type" dropdown menu, select "Web page, Filtered" (if that's an 

option) or "Web page" or "HTML."  
4. Save the Web page version to a location you can come back to (e.g. My Documents or 

Desktop). This will automatically create a subfolder that Word names "[filename]-filtered 
files" or "[filename]_files". In this subfolder are all the images contained in your original 
Word document, typically in a .GIF or .JPG format.  

The advantage of this approach is that you get the images all out at once, and the images are in a 
web-friendly format. The actual web page version of your Word document is throw-away – it’s the 
images you’re after. You can now go back to your proposal in cbfish.org and start inserting each of 
these images/charts into the rich text boxes. 
 

Q: Can I attach files to my proposal form?  
A:  Not directly. You should attach files to your project under Project Documents and set the View 
Permissions on each file to Public. The proposal form will display links to your project’s public attachments. 
These links are displayed to reviewers in the Project History section. This section also has an “Other Project 
Documents on the Web” option to add URLs linking to files elsewhere on the Internet. 
 
Q: Why can’t I enter specific GPS coordinates for my project location? 
A: On the Edit Location page of the proposal, we ask you to simply identify the general regions (fourth, fifth, 
or sixth field HUCs – Hydrologic Unit Codes) in which your project will operate. While some project Leads 
may have more specific location information, not all do, especially for work that may not start for a couple 
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years. You will have ample opportunity during contracting to enter individual lat/long locations for each 
work element in Pisces. Until then, we want to collect information at the level at which it will be reviewed; 
for proposals, the general HUC regions are enough.  
 
Q: How many HUC regions should I select for my project? 
A: On the Edit Location page of the proposal, if your project does work or plans to do work in the 
Tributaries/Watersheds (as opposed to only working in the Ocean or Estuary or Mainstem) we ask you to 
identify at least one HUC region. The main goal is to provide reviewers a quick map of where your project is 
located, so select as many regions as are necessary to provide an accurate picture. We will also use this 
information, combined with other GIS layers such as NOAA’s Listed/Threatened Anadromous Fish 
Populations, to understand which proposals may be responsive to Biological Opinions. You have a choice 
between 4th, 5th, and 6th field HUCs when you click on the map – select the level that best describes your 
project. For example, if your project operates in every 6th field HUC within a 5th field HUC, you can simply 
select the 5th field HUC and save yourself lots of clicking.  
 
Q: What’s the difference between an RM&E Metric and an RM&E Indicator? 
A: We define an RM&E Metric as a value resulting from the reduction or processing of field or lab RM&E 
Measurements, and an RM&E Indicator as a reported value resulting from the processing of RM&E Metrics 
or Measurements; a value used to indicate the status, condition, or trend of a resource or ecological 
process. For additional information view the definitions in Monitoring Resources’ glossary: 
https://www.monitoringresources.org/Resources/Glossary/Index. 
 
Q: What do I do if I’m really stuck? 
A:  Three options: Select “Request Support” from the Help menu in the top-right corner of any page within 
the cbfish.org site; email us at support@cbfish.org, or call your BPA project manager.  
 
Q: What happens when I submit my proposal? 
A: You may submit your proposal when you have all green checkmarks on the navigation sidebar. 
Remember, green checkmarks on the navigation sidebar may still be edited up until you hit the submit 
button. We strongly encourage you to review your proposal before submitting. The check marks indicate 
that it appears you have entered information, but it doesn’t judge quality or if you entered all the 
information needed.  

Once submitted, you may not edit your proposal (you will only be able to see the “Summary” view of it). If 
you submit your proposal in error, use the “Request Support” link found at the top of every page in 
cbfish.org - depending on the circumstances, they may be able to help you out.  

Once submitted, reviewers can start reviewing your proposal, even before the official close of the proposal 
period. The first team of reviewers will most likely be the Independent Scientific Review Panel (ISRP). 
 
Q: Is my proposal visible to the public?  
A: Depends on what “state” your proposal is in. When in Draft state the following people (logged in), can 
both see and edit your proposal: the person who created the proposal; the proposal’s Primary Contact; the 
BPA Project Manager assigned to the project on which the proposal is based; and anyone belonging to one 
of the project’s “Proponent” or Sponsor Organizations. 
When in the Submitted state, but during the period in which the review still accepts proposals, the same 
people listed above can see but not edit your proposal.  

https://www.monitoringresources.org/Resources/Glossary/Index
mailto:support@cbfish.org
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When in Submitted state, but after the period in which the review accepts proposals, everyone can see but 
not edit your proposal. To be clear, visitors to cbfish.org will not have to be logged in to see your proposal. 
This is consistent with people today being able to view information about your project.  
 
Thank you for your questions! 
Have a question not answered here? Select “Request Support” from the Help menu in the top-right corner 
of any page within the cbfish.org site. Alternatively, you can email us at support@cbfish.org. 
 
  

mailto:support@cbfish.org
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Useful links 
 
FISH AND WILDLIFE PROGRAM REFERENCES 
Council’s website for general information: 

http://www.nwcouncil.org/fw 
Council’s 2014 Fish and Wildlife Program: 

https://www.nwcouncil.org/reports/2014-columbia-river-basin-fish-and-wildlife-program 
Subbasin Plans: 

https://www.nwcouncil.org/subbasin-plans 
Council’s Project Reviews and Recommendations 

General page: 
https://www.nwcouncil.org/fish-and-wildlife/project-reviews-and-recommendations 
Council decision on RME/Artificial Production Review (2011):   
https://www.nwcouncil.org/sites/default/files/2011_06decision_0.pdf 
Council decisions on 2013 Resident Fish / data Mgmt / Regional Coordination 
https://www.nwcouncil.org/fw/budget/2013/ 

Independent Scientific Review Panel (ISRP): 
https://www.nwcouncil.org/fish-and-wildlife/fw-independent-advisory-committees/independent-scientific-review-
panel 
ISRP Reports: https://www.nwcouncil.org/reports?tags%5B0%5D=ISRP 

Independent Scientific Advisory Board (ISAB): 
https://www.nwcouncil.org/fish-and-wildlife/fw-independent-advisory-committees/independent-scientific-advisory-
board 
ISAB Reports:  https://www.nwcouncil.org/reports?tags%5B0%5D=ISAB 

Resource Tools and Maps: (Fish Objectives Maps, Fish Info Site, Subbasin Species & Dashboards, 
High Level Indicators): 

https://www.nwcouncil.org/fish-and-wildlife/previous-programs/fish-and-wildlife-program-resource-maps/data-0  
2012 Program Evaluation and Reporting Committee (PERC): 

https://www.nwcouncil.org/fw/program/perc 
Council decision on PERC - November 2012:  

https://www.nwcouncil.org/sites/default/files/2012_1106_1.pdf 
 

BIOLOGICAL OPINION REFERENCES 
FCRPS: 

https://www.salmonrecovery.gov/BiologicalOpinions/FCRPSBiOp.aspx 
Willamette: 

https://www.westcoast.fisheries.noaa.gov/fish_passage/willamette_opinion/ 
Kootenai River: 

https://www.fws.gov/pacific/finalbiop/biop.html 
 
MONITORING RESOURCES METHODS AND PROTOCOLS REFERENCES 
Main website: 

http://www.monitoringresources.org 
List of Protocols: 

https://www.monitoringresources.org/Document/Protocol/Index   
List of Methods:  

https://www.monitoringresources.org/Document/Method/Index  
Glossary of terms including definition of measurement, metrics, and indicators: 

https://www.monitoringresources.org/Resources/Glossary/Index  

 
  

http://www.nwcouncil.org/fw
https://www.nwcouncil.org/reports/2014-columbia-river-basin-fish-and-wildlife-program
https://www.nwcouncil.org/subbasin-plans
https://www.nwcouncil.org/fish-and-wildlife/project-reviews-and-recommendations
https://www.nwcouncil.org/sites/default/files/2011_06decision_0.pdf
https://www.nwcouncil.org/fish-and-wildlife/fw-independent-advisory-committees/independent-scientific-review-panel
https://www.nwcouncil.org/fish-and-wildlife/fw-independent-advisory-committees/independent-scientific-review-panel
https://www.nwcouncil.org/fish-and-wildlife/fw-independent-advisory-committees/independent-scientific-advisory-board
https://www.nwcouncil.org/fish-and-wildlife/fw-independent-advisory-committees/independent-scientific-advisory-board
https://www.nwcouncil.org/fish-and-wildlife/previous-programs/fish-and-wildlife-program-resource-maps/data-0
https://www.nwcouncil.org/fw/program/perc
https://www.salmonrecovery.gov/BiologicalOpinions/FCRPSBiOp.aspx
https://www.westcoast.fisheries.noaa.gov/fish_passage/willamette_opinion/
http://www.monitoringresources.org/
https://www.monitoringresources.org/Document/Protocol/Index
https://www.monitoringresources.org/Document/Method/Index
https://www.monitoringresources.org/Resources/Glossary/Index
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DATA MANAGEMENT REFERENCES 
PNAMP Data Management Resources: 
https://www.pnamp.org/topics/2  

 
FISH STATUS AND TREND MONITORING REFERENCES 
Anadromous Salmonid Monitoring Strategy from the Columbia Basin Coordinated 
Anadromous Monitoring Workshop (ASMS): 

https://www.nwcouncil.org/fish-and-wildlife/adaptivemanagement/monitoring/monitoring-strategies/asms-2009-
workshop-documents-originally-in-council-dropbox-0 

 
HATCHERY REFERENCES 
2008 Final Report of the Ad Hoc Supplementation Monitoring and Evaluation Workgroup 
(AHSWG). Recommendations for Broad Scale Monitoring to Evaluate the Effects of 
Hatchery Supplementation on the Fitness of Natural Salmon and Steelhead Populations: 

https://www.nwfsc.noaa.gov/assets/11/6509_03302009_114410_Final_Draft_AHSWG_report.pdf 
Hatchery Scientific Review Group (HSRG): 

http://hatcheryreform.us/ 
Web-based tool for assessing the effects of sampling rate, marking rate, and population 
size on the statistical precision of hatchery and natural escapement estimates, and to 
facilitate the design of BACI (Before-After Control-Impact)-type experiments: 

http://www.OneFishTwoFish.net 
 

TRIBUTARY HABITAT STATUS & ACTION EFFECTIVENESS 
Anadromous Salmonid Monitoring Strategy from the Columbia Basin Coordinated 
Anadromous Monitoring Workshop (ASMS): 

https://www.nwcouncil.org/fish-and-wildlife/adaptivemanagement/monitoring/monitoring-strategies/asms-2009-
workshop-documents-originally-in-council-dropbox-0 

PNAMP Effectiveness Monitoring Resources: 
https://www.pnamp.org/topics/6  

Council’s M&E Workgroup: 
https://www.nwcouncil.org/fish-and-wildlife/fw-forums-and-workgroups/habitat-me-workgroup  

 
 
 

https://www.pnamp.org/topics/2
https://www.nwcouncil.org/fish-and-wildlife/adaptivemanagement/monitoring/monitoring-strategies/asms-2009-workshop-documents-originally-in-council-dropbox-0
https://www.nwcouncil.org/fish-and-wildlife/adaptivemanagement/monitoring/monitoring-strategies/asms-2009-workshop-documents-originally-in-council-dropbox-0
https://www.nwfsc.noaa.gov/assets/11/6509_03302009_114410_Final_Draft_AHSWG_report.pdf
http://hatcheryreform.us/
http://www.onefishtwofish.net/
https://www.nwcouncil.org/fish-and-wildlife/adaptivemanagement/monitoring/monitoring-strategies/asms-2009-workshop-documents-originally-in-council-dropbox-0
https://www.nwcouncil.org/fish-and-wildlife/adaptivemanagement/monitoring/monitoring-strategies/asms-2009-workshop-documents-originally-in-council-dropbox-0
https://www.pnamp.org/topics/6
https://www.nwcouncil.org/fish-and-wildlife/fw-forums-and-workgroups/habitat-me-workgroup
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